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Copyright and Software License Agreement 
IMPORTANT: By clicking on the I ACCEPT checkbox and/or by accessing any part of GPmicro Inc.’s dinKum Backup and 
Restore Service (the “Service”) you are representing that you are at least 18 years of age (in the case of a natural person) or that 
you are authorized on behalf of the entity that is accessing the Service to do so, and in either instance that you and/or any 
entity (a “Client”) are agreeing to the terms and conditions of this Service Agreement. You consent to be bound by and become 
a party to this Service Agreement. If you do not agree to all of the terms and conditions of this Service Agreement click the 
CANCEL button, the registration process will not continue and you will have no authority to use the Service.  
  
If you are deemed to have ordered the Service, acceptance is expressly conditioned upon your assent to all of the terms and 
conditions of this Service Agreement, to the exclusion of all other terms or conditions. The terms and conditions of this Service 
Agreement are considered an offer by GPmicro, Inc. and your acceptance is limited to these terms and conditions. 
  
TERMS AND CONDITIONS 
  
1. Provisions 
 
All provisions of this Service Agreement apply to the Client’s Principal Account and any Associate Accounts billed to the 
Principal Account. The benefits or rights conferred by this Service Agreement are non-transferable. Use of the Service is 
expressly limited to the individual or business whose name appears on this account. 
  
2. The Service 
  
The Service consists of Client dinKum Backup Software, data encryption (during data transmission and ongoing storage), data 
access and data storage and retrieval. 
  
You are responsible for obtaining and maintaining all computer hardware and communications equipment needed to access the 
Service and for paying all third party access charges (e.g. kiosk, ISP, telecommunications) incurred while using the Service. 
  
GPmicro, Inc. reserves the right to terminate this Service Agreement and/or delete data without notice for those accounts that 
remain unpaid after two consecutive billing periods have transpired.  
  
3. Use of Proprietary Software 
  
Subject to the terms and conditions of this Service Agreement GPmicro, Inc. and the manufacturers grant the Client a personal, 
revocable, non-sublicensable, non-exclusive, non-transferable license (the “License”) to use its proprietary dinKum Backup 
software in object code form only, and only in accordance with the applicable documentation, if any, and only in conjunction 
with this Service Agreement. You will not directly or indirectly reverse engineer, decompile, or otherwise attempt to discover 
the source code or underlying algorithms of the software; modify, translate or create derivative products of the software; or 
copy (except for archival purposes), rent, lease, assign or otherwise transfer any rights to the software, use the software for 
timesharing or service bureau purposes or otherwise for the benefit of any other party; or remove any proprietary notices or 
labels on the software. You acknowledge and agree that GPmicro, Inc., the manufacturer and its associated companies have 
ownership of all software, any copies thereof, and all trademarks and patents related in any way to the Service. This Software is 
also protected by one or more U.S. Patents including U.S. patent 7,047,377and copyright laws and international treaty 
provisions. Upon termination of this Service Agreement for any reason the License will terminate and you will destroy any 
materials or documentation received from GPmicro, Inc. and ceases to use the Service. The software and Service is provided 
“AS IS” with all faults and is subject to the warranty disclaimers and limitations of liability of this Service Agreement. 
  
4. Restrictions and Policies 
  
You agree not to transmit through the Service any unlawful, harassing, libelous, abusive threatening harmful, obscene or 
otherwise objectionable material of any kind. You will use the Service for lawful purposes only in compliance with all applicable 
laws including without limitation, copyright, trademark, obscenity and defamation laws. Unlawful uses of the Service include 
(without limitation) storing, distributing or transmitting any unlawful material, attempting to compromise the Service or any 
networked account or site, or making direct threats of physical abuse. You hereby agree to indemnify, defend and hold 
harmless GPmicro, Inc. any affiliates against claims that arise from your use of the Service in an unlawful manner or manner 
inconsistent with the restrictions and policies stated herein. 
  
It is the policy of GPmicro, Inc. to respect the privacy of its Clients. Nevertheless, GPmicro, Inc. reserves the right to access 
and disclose information, data, graphics, video, sound, files and other content provided by, or accessed by you (“Content”) in 
order to comply with applicable laws and lawful government requests, to operate its business properly or to protect itself from 
liability. This may also include disclosing licenses, names and other registration and identification information to third parties. 
GPmicro, Inc. reserves the right in its sole discretion, but will not be obligated to delete any Content from its system. GPmicro, 
Inc. will fully cooperate with law enforcement authorities in investigating persons suspected of violating any laws, and reserves 
the right to report to such authorities any suspect behavior it becomes aware of.  
  
5. Support 
  
Subject to the terms hereof, GPmicro, Inc. will provide you with email and phone support for the Service and associated 
Software to resolve technical or operational issues which may exist as barriers to the Client’s satisfactory use of the dinKum 



GPMICRO, INC. © 2012 (0318) 

 4 

Backup and Restore Service. Under no circumstances will GPmicro, Inc. have any obligation to provide you with hard copy 
documentation, upgrades enhancements, or modifications to the Service or its associated software. 
  
6. Payment of Fees 
  
You agree to pay GPmicro, Inc. all charges relating to the use of the Client’s Accounts according to the prices published by 
GPmicro, Inc. including a one-time set up fee per Client, if applicable. 
  
You agree to provide GPmicro, Inc. with accurate and correct billing information, including your legal name, address and 
telephone number and you agree to update this information within 30 days of any change to it. Payment for the Service by 
fraudulent means will result in immediate and permanent termination of your Accounts, and possible criminal penalties. 
Throughout the term of this Service Agreement you agree to pay GPmicro, Inc. by check, or authorized credit card the 
applicable fees for the Service (the “Fees”). GPmicro, Inc. reserves the right to change the Fees or applicable charges and to 
institute new charges upon 30 days prior written notice to you. The Fees will be charged monthly in advance.  
  
Your GPmicro, Inc. account will be considered delinquent if you fail to pay after 2 consecutive billing periods have transpired 
and your credit card company refuses for any reason to process or pay the amount billed to it or if any amount remains unpaid 
at the beginning of the next billing cycle. Accounts that are delinquent for more than one accounting cycle may be suspended 
or purged from the system. GPmicro, Inc. may impose a charge to reinstate archived data for delinquent accounts and a 
security deposit may be assessed prior to reinstatement.  
  
For Clients that require custom specification service solutions GPmicro, Inc. reserves the right to assess a security deposit that 
must be paid a minimum of four weeks prior to the commencement of the Service 
  
If you believe GPmicro, Inc. has billed you incorrectly you must contact GPmicro, Inc. no later than 60 days after the closing 
date on the first statement in which the error or problem appeared in order to request an adjustment or credit. Inquiries must 
be in writing and be directed to the GPmicro, Inc. Customer Service Department; emails are acceptable as means of 
communication.  
  
Payment for invoices issued in any given month must be received by GPmicro, Inc. no later than 30 days after the mailing date 
of the invoice, or the Service may be terminated if payment is not received after the next billing cycle is ended. All unpaid 
invoices are subject to interest of 1.5% per month of the outstanding balance or the maximum rate permitted by law, plus all 
expenses of collection. When paying by check, Client expressly authorizes GPmicro, Inc. to debit Client’s checking account 
with the amount of a check returned unpaid by Client’s bank plus a $25 returned check fee.  
  
7. Termination  
  
GPmicro, Inc. in its sole discretion may terminate your access to and use of the Service and will be entitled to remove and 
discard any data within its system if you fail to comply with any provision of this Service Agreement. You may terminate your 
usage upon notice to GPmicro, Inc. at any time; however you will not receive any portion of your fees paid to GPmicro, Inc. 
upon termination. Further, all restrictions on the Proprietary Software and warranty disclaimers survive termination of this 
license. Upon termination, your right to use your Accounts and the Service immediately ceases. GPmicro, Inc. shall have no 
obligation to maintain any data stored in your Accounts or to forward any data to you or any third party upon termination. 
  
To cancel the Service you must contact GPmicro Customer Service Department via email, fax, mail or phone.  
  
Upon expiration or termination, you will immediately cease all usage of the software and Service. Except for the limited License 
granted in Section 3 and except as otherwise expressly provided herein to the contrary all provisions of this Agreement which 
by their nature should survive termination, including without limitation, accrued rights to payment, disclaimers and limitations 
of liability, shall survive any termination of this Service Agreement Termination is not an excuse for nonperformance by the 
Client and all remedies will be available to GPmicro, Inc. whether or not the License granted by this Service Agreement has 
been terminated.  
  
8. Warranty Disclaimer 
  
No warranty applies if the software or other portions of the Service have been altered, except by GPmicro, Inc. and/or its 
distributors or suppliers, or if it has not been installed, operated, repaired or maintained in accordance with instructions 
supplied by GPmicro, Inc. 
  
DISCLAIMER: Except as specified in this Warranty, all express or implied conditions, representations, and warranties 
including but not limited to any implied warranty of merchantability, fitness for a particular purpose, correspondence with 
description, non-infringement of a third party’s property rights, lack of a virus in the software, usage or trade practice are 
hereby excluded to the extent allowed by applicable law. No indemnity exists for direct, contributory or other kind of 
infringement of a third party’s property rights. In no event will GPmicro, Inc., its suppliers or its distributors be liable for any 
indirect, incidental, special, punitive, or consequential damages or any lost revenue, profit or data. GPmicro, Inc., its suppliers’ 
or its distributors’ maximum liability for any damages whether in contract or in tort will not exceed the amount which Client 
has paid for this order and if such damages result from Client’s use of a Software program or technical support, the liability 
shall be limited to the amount paid for the relevant Software program or technical support. The above Warranty DOES NOT 
apply to any beta software, any software made available for testing or demonstration purposes, any temporary software modules 
or any software for which GPmicro, Inc. does not receive a license or subscription fee. All such software products are provided 
AS IS without any warranty whatsoever.  
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9. Limitation of Liability 
  
Client expressly agrees that use of dinKum Backup and Restore Services is at Client’s sole risk. Neither GPmicro, Inc. its 
employees, affiliates, agents, third party information providers, merchants, licensors or the like warrant that the dinKum 
Backup and Restore Service will not be interrupted nor error free; nor do they make any warranty as to the results that may be 
obtained from the use of the Service.  
  
Under no circumstances, shall GPmicro, Inc., its officers, agents or any one else involved in creating, producing or distributing 
the dinKum Backup and Restore Service be liable for any direct, indirect, incidental, special or consequential damages or 
punitive damages that result from the use of or inability to use the dinKum Backup and Restore Service; or that result from 
mistakes, omissions, interruptions, deletion of files, errors, defects, delays in operation, or transmission or any failure of 
performance, whether or not limited to acts of God, communication failure, theft, destruction or unauthorized access to 
GPmicro’s records, programs or services.  
  
GPmicro’s total liability, if any, with respect to the subject matter of this Service Agreement (including but not limited to 
liability arising out of contract, tort or otherwise) is limited to the Fees paid by you to GPmicro, Inc. for the Service under this 
Service Agreement in the month prior to the act or omission that gave rise to the alleged liability. In no event will GPmicro, 
Inc. and its licensors be liable for loss or inaccuracy of data, loss of profits or revenue, whether direct or indirect, or any special, 
incidental, consequential or punitive damages, whether or not foreseeable and whether or not GPmicro, Inc. has been advised 
of the possibility of said damages. 
  
10. U.S. Government Matters 
  
You may not remove or export from the United States or allow the re-export of any part of the software or applicable 
documentation or any direct product thereof in violation of any restrictions, laws of the United States Department of 
Commerce, the United States Treasury Office of Foreign Assets Control, or any other United States agency or authority. As 
defined in FAR section 2.101 the software and documentation licensed in this Service Agreement are “commercial items” and 
according to DFAR section 252.227-7014(a)(1) and (5) are deemed to be “commercial computer software” and “commercial 
software documentation.” Consistent with DFAR section 2277.7220 and section 12.212 any use, modification, reproduction, 
release, display or disclosure of such commercial software or commercial software documentation by the U.S. Government will 
be governed solely by the terms of this Service Agreement and will be prohibited except to the extent expressly permitted by 
the terms of this Service Agreement. 
  
11. Miscellaneous 
  
The failure of either party to exercise in any respect any right provided herein will not be deemed to be a waiver of any further 
rights hereunder, or if any provision of this Service Agreement is found to be unenforceable then that provision will be limited 
or eliminated to the minimum extent possible so that this Service Agreement will otherwise remain in full force and effect. This 
Service Agreement is not assignable, transferable or sublicensable by you except with the prior written consent of GPmicro, 
Inc. who may withhold such consent in its sole and absolute discretion. This Service Agreement will be governed and construed 
in accordance with the laws of the state of Nevada. Both parties agree that this Service Agreement contains the exclusive 
statement of the mutual understanding of the parties and supersedes and cancels all previous written and oral agreements, 
communications and other understandings relating to the subject matter of this Service Agreement, and that all modifications 
must be in a written form and signed by both parties. No agency, joint venture or employment arrangement is created as a 
result of this Service Agreement and you do not have any authority of any kind to bind GPmicro, Inc. in any respect 
whatsoever. In any action or proceeding to enforce the rights under this Service Agreement the prevailing party will be entitled 
to recover its attorneys’ fees. All notices under this Service Agreement will be deemed to have been duly given when received, if 
personally delivered, when receipt is electronically confirmed, if transmitted by facsimile or email; the day after it is sent if sent 
for next day delivery by any overnight delivery service; and upon receipt, if sent by certified mail, return receipt requested. 
  
GPmicro, Inc. may assign this Service Agreement, its rights hereunder and its ownership of said Service and commitment to 
another entity at any time without notice or consent.  
  
In addition to any price specified herein, Client shall pay the gross amount of any present or future sales, use, excise, value 
added or other similar taxes applicable to the price, sales or delivery of products or services furnished hereunder.  
  
GPmicro, Inc. may (but shall not be obligated to) offer credits to Clients who refer additional users who sign up for and keep 
GPmicro, Inc. accounts through at least 1 year of billing cycles provided that the new users signing up mention at time of 
signup the name of the Client who referred them. This incentive may be revoked or cancelled by GPmicro, Inc. at any time 
without prior notice. 
  
Please note that the software in this program created by the software manufacturer cooperates with various routines generated 
under the Open Source code initiative. This license details the license requirements associated with each of these routines 
generated under the Open Source code initiative. 
 

A. 7-zip compression utility 
 
Copyright © 2005 Igor Pavlov 
 
The 7-Zip compression utility is covered by the GNU Lesser General Public License, which can be read in its entirety at 
http://www.gnu.org/copyleft/lesser.html#SEC1#SEC1. 
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B. CsizingControl Bar Utility Version 2.44 
 
Created Jan 24, 1998 
 
Last Modified: March 31, 2002 
 
Copyright © 1998-2002 by Cristi Posea. All rights reserved. 
 
Please see the official site at www.datamekanix.com for documentation and the latest news. This code is free for personal and 
commercial use, providing this notice remains intact in the source files and source files and all eventual changes are clearly 
marked with comments. You must obtain the author's consent before you can include this code in a software library. No 
warranties of any kind, express or implied, is included with this software, use at your own risk, responsibility for damages (if 
any) to anyone resulting from use of this software rests entirely with the user. Send bug reports, bug fixes, enhancements, 
requests, flames, etc. to cristi@datamekanix.com or post them at the message board at the site. 
 

C. SystemTray 
 
SystemTray.h: header file 
 
Written by Chris Maunder (cmaunder@mail.com) 
 
Copyright © 1998. 
 
This code may be used in compiled form in any way you desire. This file may be redistributed unmodified by any means 
PROVIDING, it is not sold for profit without the authors written consent, and providing that this notice and the authors name 
is included. If the source code in this file is used in any commercial application then acknowledgement must be made to the 
author of this file (in whatever form you wish). This file is provided "as is" with no expressed or implied warranty. 
 

D. BCMenu 
 
By Brent Corkum 
 
BCMenu.h: header file - Version: 3.033 
 
Date April 2002 
 
Author Brent Corkum 
 
Email: corkum@rocscience.com/~corkum/BCMenu.html 
 
Latest Version: http://www.rocscience.com/~corkum/BCMenu.html 
 
Bug Fixes and portions of code supplied by: 
Ben Ashley, Grish Bharadwaj, Jean-Edouard Lachand-Robert, Robert Edward Caldecott, Kenny Goers, Leonardo Zide, Stefan 
Kuhr, Reiner Jung, Martin Vladic, Kim Yoo Chui, Oz Solomonovich, Tongzhe Cui, Stephane Clog, Warren Stevens, Damir 
Valiulin, David Kinder, Marc Loiry. 
You are free to use/modify this code but leave this header intact. This class is public domain so you are free to use it in any of 
your applications (Freeware, Shareware, Commercial) All I ask is that you let me know so that if you have a real winner I can 
brag to my buddies that some of my code is in your app. I also wouldn't mind if you sent me a copy of your application since I 
like to play with new stuff. 
  

E. The OpenSSL Project 
 
Copyright © 1998-2003 The OpenSSL Project. All rights reserved. 
 

1. Redistribution of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer.  

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 
disclaimer in the documentation and/or other materials provided with the distribution.  

3. All advertising materials mentioning features or use of this software must display the following acknowledgment: 
"This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. 
(http://www.openssl.org/)"  

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived 
from this software without prior written permission. For written permission, please contact openssl-
core@openssl.org.  

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names 
without prior written permission of the OpenSSL Project.  

6. Redistributions of any form whatsoever must retain the following acknowledgement: "This product includes 
software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)" 

  
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED 
WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL 
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PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software 
written by Tim Hudson (tjh@cryptsoft.com). 
 

F. Original SSLeay License 
 
Copyright © 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved. 
 
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to 
conform with Netscape's SSL. This library is free for commercial and non-commercial use as long as the following conditions 
are adhered to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, 1hash, DES, etc., 
code; not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright terms 
except that the holder is Tim Hudson (tjh@cryptsoft.com). 
 
Copyright remains Eric Young's, and as such and Copyright notices in the code are not to be removed. If this package is used 
in a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the form of a 
textual message at program startup or in documentation (online or textual) provided with the package.  
 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 
 

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.  
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following 

disclaimer in the documentation and/or other materials provided with the distribution.  
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: " 

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" Note: the word 
'cryptographic' can be left out if the routines from the library being used are not cryptographic related.  

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you 
must include an acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"  

 
This software is provided by Eric Young "AS IS" and any express or implied warranties, including but not limited to the 
implied warranties or merchantability and fitness for a particular purpose are disclaimed. In no event shall the author or 
contributors be liable for any direct, indirect incidental, special, exemplary, or consequential damages (including, but not limited 
to, procurement of substitute goods or services; loss of use, data or profits or business interruption) however caused and on 
any theory of liability, whether in contract. Strict liability, or tort (including negligence or otherwise) arising in any way out of 
the use of this software, even if advised of the possibility of such damage. 
 
The license and distribution terms for any publicly available version or derivative of this code cannot be changed; that is, this 
code cannot simply be copied and put under another distribution license (including the GNU Public License).  
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1. System Requirements 
The following minimum system requirements are recommended: 

PC with 1 GHz processor (CPU) or faster 

Windows XP or later Operating System 

Memory 256 megabytes (MB) of RAM 

For offsite/online backup a high-speed Internet connection; such as, DSL, cable, T1 or similar is 
recommended. 

2. Introduction 
hether you are an individual or a business, your information is important. In this 
time of identity theft, government regulations for compliance, cyber-terrorism, 
natural disasters and other uncertain eventualities, it is important to take steps to 
protect your most critical information for your security and peace of mind. One 

way to help minimize the impact of loss of information is to have secure, off-site backup and 
recovery solutions in place in order to protect your data.  

GPmicro Inc.’s dinKum™ provides a data backup and recovery solution that is cost 
effective and simple enough for the average home user, yet sophisticated enough for any 
small to mid-size business. Moreover, elements of our process can be customized to meet 
unique needs. 

Why backup? Data loss can be catastrophic for businesses, causing costly downtime and the 
loss of valuable information. With the amount of data stored on servers, computer hard 
drives and portable storage devices amounting to terabytes (thousands of gigabytes), taking 
precautions could literally save your business. 

Yet, the truth is, many business people are extremely busy running their day to day 
operations and forget about the possibility of disaster, legal inquiries, employee issues and 
the like, and put off sorting out a data backup solution. Don’t panic yet, if you haven’t put a 
system in place, GPmicro’s team will help you develop a backup and recovery strategy that 
fits your needs and budget. 

The first step in setting up a working backup procedure is to decide what you need to back 
up and when. Initially, you will need to take a complete ‘snapshot’ (also called an ‘image’) of 
everything on your computer, copying any registry details and all software programs. This 
means that all data on your computer at the moment of backup will be saved. 

Getting Started 

W 



GPMICRO, INC. © 2012 (0318) 

 9 

In addition, when you install new software, take a snapshot of your current setup before you 
install it in case it causes a problem on your computer that you might want to reverse. Then 
take another snapshot after the software has been installed, after you’ve had time to check 
that everything is working as it should.  

Next, make sure to schedule the backup of your changing data files, such as new documents, 
contacts and emails, on a regular basis. It depends on how much work you do each day as to 
the time lapse that you think you can risk between backups. dinKum™ recommends daily, 
but when you are working on an important project, it may be more prudent to use the 
‘‘backup now” option for more recent backups. 

If you have any data that is particularly valuable and is unlikely to change, such as photos or 
legal documents, you should consider archiving these to a safe, long-term storage, perhaps 
on a monthly basis. dinKum’s™ offsite/online backup service keeps up to three versions of 
your files; just in case you need to restore a previous version and the free local backup keeps 
all file versions. 

Once your backup system is in place, you can rest assured that in the event of any type of 
computer failure, theft, fire, or water damage, you won’t lose information that is priceless to 
your business. 
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3. Download the dinKum Data Backup Software 
When installing, uninstalling or upgrading the dinKum Backup software it is 
necessary that you are logged in to your computer as a user with ‘Administrator’ 
privileges otherwise the installation will fail. 

You can obtain the dinKumBackupInstaller.exe file from the www.gpmicro.com website by 
clicking on the ‘Download’ button at the top of the main webpage. Before the download of 
the software occurs the following message might appear on your screen.  

 

 
 
Click on 'Save' to save the file on your local hard drive. 
 

Now specify a location for the file to be stored to. 

 
 

 
After you choose the location click the 'Save' button and the download process will begin. 
Remember this location in case you ever need to re-install the software. 
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Important! Before installing the dinKum™ Data Backup software it is recommended that 
all open programs including virus protection and other programs that may be running in the 
background are temporarily closed. 

 

 
 
After the download is complete click on ‘Run’ to begin the installation process. 
 
If you saved the download and did not click ‘Run’, then you will need to locate the file on 
your computer and 'Double click' on the file dinKumBackupInstaller.exe with the left mouse 
button. Click ‘Continue’ or ‘Yes’ to proceed if Windows asks for confirmation. 
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4. The Installation Process 
 

 
 
The following screenshots are examples of what you might see on your screen during the 
installation process. You will need to click 'Next' to go to the next screen. At any time, if 
available, you can click the ‘Back’ button to go to the previous screen or click on ‘Cancel’ to 
stop and abort the installation process. 
 

4.1. Choosing New Install or Upgrade 
 
If you are installing the dinKum™ Data Backup software for the first time then 
proceed directly to the Licensing Agreement page – Section 4.2. 
 
If you already have the software installed on your computer, you must choose one of the 
following options by clicking on the appropriate button. If you choose ‘Uninstall but keep 
settings’ (the default), your previous configuration along with log files, and other user created 
information will remain intact. Otherwise, if you choose ‘Uninstall completely’ all prior 
information will be removed before installing the new software version and will be treated as 
a completely new install. 
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The following progress window will be displayed while the current software is uninstalled. 
This could take several minutes. 
 

 
 
 

4.2. Licensing Agreement 
 
Please read the Software License Agreement pertaining to dinKum™. You must click on the 
‘Yes, I accept the Terms of this License Agreement’ check box in order to proceed. Click 
'Next' to continue. 
 
The License Agreement can be found under ‘Help’ in the Backup Manager program after the 
installation is complete for future reference. 
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4.3. Starting the Installation Process  
 
To proceed with the installation, click 'Next'. In the event that you are reinstalling the 
software make sure that the Backup Manager or any other related applications are not 
running at this time. The installer attempts to close them but it is best to close these 
applications to prevent any potential conflicts. 
 

 
 

 
The installation process can take several minutes to complete. 
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Note: The installation is not complete, yet. It is necessary to have access to the Internet for 
the offsite/online data backup configuration. The local only backup setup and configuration 
does not require an Internet connection.  
 

5. The Configuration Process 
 
On the first screen of the configuration wizard, select the button that corresponds to the 
initial type of installation you wish to have. The choices are either the installation for Local 
Backups or for Offsite Backups. After installation, you can configure the other option from 
within the Backup Manager. If you cancel the installation at this point, you will be required 
to configure the installation the first time you run the Backup Manager. 
 
WARNING: Backups will NOT occur until you successfully configure your backup 
software. 
 

5.1. Configuring Local Backups 
 
If you click on ‘Install for Local Backups’, you will see the following screens. If you choose 
‘Install for Offsite Backups’, proceed to Section 5.2 ‘Configure Offsite Backups’ for 
instructions. 
 
NOTE: The ‘Select Drive’ dialog window will display above the ‘Local Backup Storage’ 
screen of the wizard if you have not already selected a local storage drive.  
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NOTE: If you do not have any attached disk drives, you may see the following message. 
Insert an external drive and click ‘Refresh’ to be able to select an attached drive. It may take 
time for the drive to show in the select list. Click ‘Refresh’ until the drive appears. 
 

 
 

Select a removable/attached drive or a mapped drive that you wish to use for your local 
backup storage and then click ‘OK’ to continue.  
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When a mapped drive is selected as the backup storage location then the following message 
appears. In order for the backup to occur even when the user is not logged into the 
computer the mapping credentials such as username and password are required. 

 
 

 
 
NOTE: It is not recommended to use internal disks – especially not your C-drive for 
backups. But if no other drives are available internal disks can be selected by checking the 
check box ‘Include internal disks’ and then hit ‘Refresh’. After you press ‘OK’ the following 
screen appears. 
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The before selected storage location will be displayed in the Local Backup Storage 
configuration screen above. 
 
In the ‘Password’ text box, enter a password to protect your local backup data from 
unauthorized access. You must re-enter the same password in the ‘Confirm Password’ text 
box to confirm your password. Check the ‘Remember Password’ checkbox if you want the 
‘Backup Manager’ to remember your password when you access the local storage. If you do 
not check this box you will be required to enter your password when you want to view or 
restore your backups. The password is case sensitive and at least 6 characters and/or 
numbers are required and not more than 32 characters and/or numbers are accepted. 
 
If the local storage location is new, it will be initialized as a new empty local storage area and 
you must supply a new password. Once, initialized, you must always use this password to be 
able to access this storage location. 
 
If you wish to clear an already existing location and turn it into a new storage area, click on 
the ‘Clear Storage Area and Database’ checkbox. In this case, you can enter a new password. 
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WARNING: If you clear the storage area, any previous backups will be deleted. 
 
Skip the next section and proceed to Section 5.3 ‘Schedule Backups’ if you are installing for 
FREE Local Backup only. 
 
 

5.2. Configure Offsite Backups 
 

You can sign up for an offsite/online dinKum Backup account before you install the 
software from the www.gpmicro.com website or during the software configuration at the 
time of installation. In either case, you will need your username and password that you used 
during the signup process for the ‘Offsite Logon’ configuration screen. 

 

 
 
If you chose the ‘Install for Local Backups’ you can skip this section and go straight to 
Section 5.3 ‘Schedule Backups’. You can create or configure an offsite account later from the 
Backup Manager. 
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If you do not already have an offsite account or wish to create another offsite account, click 
on the ‘Create Account Now’ button. 
 
For existing customers with active offsite accounts, click the ‘Skip Create Account’ button to 
proceed to the ‘Offsite Logon’ screen (see end of Section 5.2) where you can configure an 
existing account. 
 
When you want to create an offsite account then click on the ‘Create Account Now’ button 
and the contact information form will be displayed. 
 

 
 
Fields with a “*” next to their names are required. The password is case sensitive and must 
be between 6 and 32 characters in length. After entering your contact and backup account 
information and password click on the ‘Next’ button to proceed to the charge card 
information screen. Fields showing an asterisk are required. In the ‘Account Name’ text box, 
you must enter a unique account name (case sensitive) no longer than 32 alpha-numeric 
characters. If the account name is already in use, you will be notified and allowed to re-enter 
a different account name. 
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Warning! Do not use the ‘Advanced’ button unless instructed to do so by GPmicro 
Inc.’s support personnel. 
 

 
 

 
A completed sample form is shown above. Click ‘Next’ to proceed to the Charge Card 
Information screen shown on the following page. 
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All fields are required and the correct format is shown to the right of the input field. You 
can click on ‘Help’ at any time to display a more detailed description of the fields and how to 
locate certain information from your charge card. 
 
Once you complete the Charge Card Information, click ‘Next’ to review the information you 
entered. You can confirm your information or click ‘Back’ to correct anything before 
proceeding with the account creation. 
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Click on the ‘I accept charges to my ATM or Credit Card Account’. Verify that the 
information is correct and then click ‘Next’ to finalize the account creation process. 
 
If the account creation fails or the charge card is declined, messages similar to the one below 
will be displayed. Uncheck the checkbox next to ‘I accept charges…’ which will re-activate 
the ‘Back’ button so you can go back and correct any information and try again. 
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When successful then your offsite/online backup account has been created and is now ready 
to accept backups but before you can back up to your account; your backup software must 
be configured. Click ‘Next’ to proceed to the ‘Offsite Logon’ screen. 
 
You will be asked if you wish to use the just created account information for the ‘Offsite 
Logon’ screen. If you click ‘Yes’ to the following message, the just created account 
information will be copied to the ‘Offsite Logon’ screen. If you want to configure the 
software to backup to a different account, click ‘No’ (this would only be the case when you 
already have an existing offsite account that you are using) and you need to enter the 
required information into the ‘Offsite Logon’ screen. 
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Fill out the account name, password, and unit number (always 0000 on new accounts). 
Check the ‘Remember Password’ checkbox if you wish the Backup Manager to remember 
your password.  
 
NOTE: If you do not check the ‘Remember Password’ checkbox, you will be required to 
enter your password each time you run the Backup Manager. The checkbox is unchecked by 
default for security reasons but for computers that are only under your control you may 
choose to check this box for convenience. 

 

 
 

Warning: Do not use the ‘Advanced’ button unless instructed to do so by your 
support representative. 
 
When clicking on the ‘Advanced’ button it is possible to change the default backup location 
and port number in case a different server location is used or a firewall at your end blocks 
the default port. When the default port # 7117 does not work try port # 110 as alternate. A 
‘Set default server’ checkbox allows resetting any made changes. 
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Click the ‘Next’ button to proceed to the ‘Schedule’ screen described in the ‘Schedule 
Backups’ section next. 
 
 

5.3. Schedule Backups 
 
Using the ‘Schedule’ screen you define when backups will occur. There are two choices 
when configuring a schedule, the ‘Day Selection’ defines on which day or days to perform 
backups, and the ‘Time Selection’ defines the time or times of the day to run on those days. 
 
For the ‘Time Selection’ section you have the following choices. When ‘Every x hours …' is 
selected then you can enter a whole number (integer) between 1 and 12 in the provided field. 
A '1' means that a backup occurs every hour on the hour and when a 2 is entered a backup 
will happen every two hours. The count starts at midnight, which means that when 12 is 
selected then one backup occurs at midnight and another backup occurs at noon. 
 
When 'Once a day at' is selected then enter the time in the field provided. A backup will 
occur every day at the time you specified. 
 
It is necessary for your computer to be turned on during scheduled backup times but it is 
not necessary for a user to be logged in during scheduled backups. There is an option that 
allows for shutting down the computer after the backup is complete. 
 
Note: The Windows (XP and later) operating systems allow backups to occur on files 
even when they are open during backups. 
 
Click on the ‘Help’ button to display the ‘Schedule Help’ screen. 
 
The drop down list allows you to choose the day or days for the scheduler providing the 
following options: ‘Un-scheduled’ for no schedule, this means that you need to always 
manually initiate the backup process; ‘Schedule One Day’ to run only on that day that is 
selected; ‘Schedule Weekly’ to select week days to run; or ‘Schedule Monthly’ to select days 
of the month. The ‘Day Selection’ will change to reflect the appropriate options based on 
the drop down selection. 
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For the ‘Un-scheduled’ option, both the Day and Time selection sections disappear, as they 
have no meaning for this option. 
 
NOTE: You can change the schedule later by using the Backup Manager software. 
 
When you choose ‘Schedule Weekly’ from the dropdown list, you can select the days of the 
week to run the backup. This is the default selection on a new install with all days of the 
week selected. This will run the backup every day. 
 
The days can be checked or unchecked individually, or you can use the ‘Select all days’ or 
‘Un-select all days’ checkbox for convenience. 
 
You can select ‘Schedule One Day’ from the dropdown list if you want to run the backup on 
only one specific date. A calendar in the ‘Day Selection’ section will be presented for you to 
choose the date. If you choose this option for the initial backup and wish to create a 
repeating schedule later, you can change this from within the Backup Manager. 
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Otherwise, the backup will only run on that date and you will have to run them manually 
after that or change the schedule from the Backup Manager. 
 
Note that you can run the backup multiple times on the selected date by choosing ‘Every X 
hours …’ option in the ‘Time Selection’ section. Once the date passes, the backup will no 
longer run and act as though ‘Un-scheduled’ were selected. 

 

 
 
Select ‘Schedule Monthly’ from the dropdown list if you want to select specific days of the 
month to run backups. When you choose this option, you will be presented with checkboxes 
for each day of the month. Check the days you want backups to run, and uncheck those days 
not to run. ‘Select all days’ and ‘Un-select all days’ are provided for convenience. 
 
For months with less than 31 days, selecting 31 will not run a backup on this day for these 
months. To handle this situation, check ‘Perform backup on last day of month’ to force a 
backup on the last day of every month. This will always run a backup on the last day of the 
month regardless of the number of days in the month. 
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Without this option, you would have to select all four days (28, 29, 30, and 31), which will 
cause a backup to occur on all of the days that are checked. 
 
When clicking on the Month or Year (red oval) it is possible to directly change the months 
or years in this selection. 
 

 
 
After making your selections, click ‘Next’ to proceed to the ‘File Selection’ screen. 
 

 

5.4. Select Files to Backup 
 
The File Selection screen allows you to initially select and configure categories of files and 
folders for backup. At this time you can select categories only such as user data or program 
data on your local drive. The Backup Manager is the actual tool for the configuration of 
backup settings that will allow selecting individual files and folders on local, attached and 
mapped drives. The information is maintained in a file called a Manifest (or File List) file. In 
the ‘File Selection’ window there are two options of selecting a Manifest file: Existing file list 
file, including the option to ‘Browse’, or ‘New file list file’. Not all of these options may be 
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available depending on whether this is a new installation or a re-installation. The choices will 
be enabled if available. 
 
On a new install the ‘New file list file’ option allows you to quickly create a new list of the 
most common files that should be backed up. When you select this option, you can choose 
categories under ‘Check all that apply’. The most important items are pre-selected for this 
option by default. 
 
If you check ‘All important User data …’ checkbox, this will back up all of the user profiles. 
This includes all users’ documents, pictures, music, video, etc. These are locations that user 
created documents are typically saved to by default for almost all applications. 
 
If you check the ‘Common Program Data files and folders’ checkbox, this will backup non-
user created data stored by many applications. Often these files are required by these 
applications to run properly.  
 
Warning: Only uncheck the ‘Common Program Data files and folders’ checkbox if 
you are absolutely sure that you do not need any of these files. 
 
Check the ‘Program Files folders’ if you know or are unsure whether some applications store 
information in these installation folders. Many applications such as Quickbooks as well as 
others store both non-user and user data under ‘Program Files’. 
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Click ‘Finish’ to create the file list file and complete the configuration. After the installation 
completes, backups will automatically begin to run at their scheduled time. 
Note: You can add and remove files or folders later from the Backup Manager. These 
choices are only for the initial configuration and you can fine-tune your file selection 
later. 
 
When you are re-installing the software you also can select ‘Existing file list file’ if you 
already have a file list configured that you want to use. (This option will not be available on a 
new installation). 
 
You can browse for a known file list by selecting ‘Browse’ and selecting an existing file. This 
option is only useful if you are re-installing and one or more file list files already exists. 
 
Click on the ‘Browse’ button that is located next to the selection in order to choose the file 
from the ‘Open’ dialog box as shown below. 
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If the software has already been installed before, you may have a file list file in the ‘Recent 
file list file’ list. If this is available, select the ‘Recent file list file’ option and choose the list 
file from the dropdown list – see below. (This option is not available on new installations). 
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5.5. Completing Installation  
 
At this screen, the installation for Windows based systems is complete and the backups will 
now run according to your schedules. More information on configuring the backup process 
can be found in Section 6.5 ‘Backup Settings’. Should you plan to backup data from mapped 
drives that are located on Linux systems and it is necessary to preserve the Linux 
permissions of those files then you need to install the ‘dinkumd service’ on the Linux 
system. On the screen below you can click on the ‘Linux Share Help’ button for further 
information on configuring optional Linux shares. Section 11 discusses this process in detail.  
 
You can also automatically run the Backup Manager with the ‘Launch the dinKum Backup 
Manager …’ checkbox checked. 
 

 

 
 
On new installations, the ‘Automatically log out after installation’ checkbox is available and 
checked by default – see next page. This is only necessary the very first time you install this 
software on a computer. And it is only necessary if you intend to run the Backup Manager 
before the next time you logon and intend to backup mapped (shared) drives. If you do not 
plan to backup mapped drives then you can uncheck the checkbox. 
 
Below is a sample screen shot of the help file for configuring Linux (Samba) Shares when 
Linux file permissions are needed to be preserved during backup and restore. 
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When a mapped drive was selected as backup storage location then the provided credentials 
such as username and password are now tested to verify accessability to this storage area as 
shown below. 
 

 
 

If you are still in need of help or need more information please email us at 
support@gpmicro.com. We will be happy to answer any questions and help you start 
backing up your data. 
 

6. Starting the Backup Manager Software 
 
The tool that helps to configure backups and to manage and restore data is the ‘Backup 
Manager’. Each backup, even when it is just a single file, creates an archive on your system 
that is encrypted and compressed before it is send offsite. The ‘Backup Manager’ accesses 
these offsite archives and requires an active internet connection. The benefit is that the data 
is accessable from anywhere if needed. Below is an overview of the functionality. 
 
The dinKum Backup Manager will take a moment to come up and during this time a 
message window as shown below informs the user about the current status of the software. 
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Once the initialization of the dinKum Backup Manager is complete it will start and look like 
shown on the following screen. The Backup Manager window contains the following 
elements that are explained further below. The ‘Menu Bar’ is on the very top and the ‘Tool 
Bar’ right below it. The main area is taken up by 4 ‘Window Panes’ – ‘Backup Selection’ 
Pane, ‘Backup Listing’ Pane and ‘Backed up Folders’ Pane and a ‘Backed up Files and 
Folders’ view window at the very right hand side. The ‘Status Bar’ is located at the very 
bottom of the Backup Manager window.  
 

 
 

The ‘Backup Selection’ Pane is local to your computer and here you can select files and 
folders on your local disk as well as other drives, including mapped network drives. A ‘+’ 
sign indicates that the folder can be expanded into subfolders and/or files. A black check 
mark þ next to the files and folders indicates that this file/folder and all files/subfolders are 
selected for backup. A grey check mark þ indicates that not all files and/or subfolders are 
selected for backup. 
 
The other three windows are empty since no backup has occurred, yet. These show 
information in regards to the backed up data either offsite for offsite account holders or on a 
backup device that can be a local or mapped drive. 
 
 
  

Backed up 
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Backup 
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6.1. The Menu Bar 
 

 

The ‘Menu Bar’ is located at the top of the Backup Manager and contains commands to manage 
backup file selections, backup schedules and the backed up data. The screen shots below show 
the detailed contend of the menu bar commands. 

 

The ‘File’ menu has commands related to creating (NEW), opening (Open…) and saving (Save) 
manifest files and to exit the Backup Manager. 

 

The ‘Edit’ menu has commands for the backup and restore settings, as well as the account login 
that allows to login to different backup accounts. The third command refers to data 
synchronization and retention. Data that has been deleted or moved on the local system can be 
deleted from the backed up data, as well and therefore keeps the local and backed up data sets 
synchronized. 

Menu Bar 
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The ‘View’ menu allows refreshing of all window panes after changes to the local computer or 
when backups occurred and it allows to selectively turn the different panes on or off. When all 
options are turned off the Backup Manager looks like this: 

 

 

 

The ‘Action’ menu contains commands related to backup and restore, delete, find and backup 
schedules. Depending on the selection of the data or schedules certain commands are not 
available and therefore greyed out. 
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The ‘Tools’ menu contains commands in regards to mapped drives, schedule creation and 
creation of new backup storage locations. It has a database check and repair functions for local 
backups when needed and a command to start the log file viewer. The command ‘Backup to 
Removable Media’ is usually greyed out since this command only applies to drives shipped from 
GPmicro, Inc. for initial backups that are too large to transmit in a reasonable amount of time 
over the Internet. 

 

The ‘Window’ menu allows switching the view between either backed up files and folders view or 
a list of the existing backup schedules. 

 

 

The ‘Help’ menu contains the Software License and Service agreements, help documentation, and 
contact information. 
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6.2. The Tool Bar 
 

The Tool Bar contains shortcuts to commands that are also located in the Menu Bar. The Tool 
Bar is a subset of the commands in the Menu Bar and is provided as convenience. The Tool Bar 
can be turned on and off from the ‘View’ menu. 

 

 

 

 

 

 

 

 

6.3. The Status Bar 
 

The Status Bar is located at the bottom of the Backup Manager and contains information in 
regards to current backup location, the size and number of all selected files that will be backed up 
during the next backup session. When an archive, folder or file is selected from the offsite storage 
location then the size, number of folders and files are displayed. This information is useful in the 
case of data restore when only subsets of data are needed. This can shorten the restore time. 

 

 

 

 

 

6.4. The Window Panes 
 
The 4 window panes of the Backup Manager can be resized and the ‘Tool Bar’, ‘Backup 
Selection’ Pane, ‘Backup Listing’ Pane and ‘Backed up Folders’ Pane can be moved around 
independently (select with mouse and drag), which allows for individual customization of the 
screen. 
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6.5. Backup Settings 
 

When selecting the ‘Settings’ option from the ‘Edit’ menu of the Backup Manager allows for 
configuration of the backups and restores that go far beyond the initial configuration wizards’ 
options. Many of these options are preconfigured to common defaults but can be changed based 
on the user’s needs. On the following pages we will look at the tabs of the configuration options 
shown below. 

 

 

Each schedule has its own settings for configurations and can therefore be very different from 
other settings. The chart in section 10.5 shows the schedule dependent settings that are possible 
to configure independently. Some settings are defined globally to all schedules but most can be 
defined separately for each schedule. Changing the settings applies to the selected schedule when 
in the ‘Schedule View’ otherwise, changes to settings apply to the schedule selected in the drop 
down list of the toolbar. 

When selecting the ‘Settings’ option from the ‘Edit’ menu of the Backup Manager the following 
screen will open. 
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At the ‘Offsite Login’ screen the account name and password needs to be entered in order to be 
able to connect to your offsite/online storage account. The remember password checkbox can be 
checked to store the password locally (it will be stored encrypted for better protection). When this 
box is not checked then the password needs to be re-entered every time changes to the settings 
are being made before these changes can be applied.  
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The backup program combines files and folders that need to be backed up into ‘Archive’ files that 
are encrypted and compressed before being sent to the offsite storage location. A directory needs 
to be specified that will contain a temporary directory to store these temporary files before they 
are transferred offsite. After a successful transfer the temporary directory and these archive files 
are then removed from your local system. The temporary directory needs to be local to the 
computer and cannot be a mapped drive. In the event that the backup process was interrupted 
due to a network outage or computer shutdown the backup software attempts to reconnect after 
a connection to the offsite location has been re-established and picks up from where it left off 
during transmission. 

In the drop-down menu a maximum archive file size can be selected between 0.5 GB and 4 GB. 
Should a file be larger than the maximum selected archive size then only this one file will be 
packed into the archive. The archive size can then be considerably larger and is based on the 
individual file size. Large archives take longer to transmit than smaller archives and only after an 
archive has been transmitted completely all files and folders that it contains are backed up offsite. 
The log files contain details on which files and folders are part of each archive. 
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In the ‘Backup Type’ selection a user can decide how the backup process should select files for 
backup. Option 1 is the most common selection and when in doubt should not be changed. 
Here all files that are in the manifest selection will be backed up during the first backup process 
and after that only changes to these existing files or any newly created files will be backed up. 
Option 2 will always backup all files in the manifest independently of changes to any file. Option 
3 will only backup changed files that are part of the manifest selection. On a system that has never 
been backed up before Option 3 will function like Option 1. Should a complete backup exist and 
it is intended to only backup new files or changes to existing files then Option 3 will only backup 
those changes. Option 1 would do a complete backup of all files again before just backing up 
changes. This case would only occur if the dinKum backup software was re-installed and the user 
does not want to start over again. Option 4 is a special case that marks all files as being backed up 
without backing them up. After that only changed or new files will be backed up. This only makes 
sense when there is nothing on the computer that needs to be backed up because the computer 
just was backed up completely or it is a new computer that has no user files worth backing up, yet. 
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Restoring data from an offsite account requires space on your local computer to download the 
restore archives. Restore archives are different from your backup archives since those archives are 
packed on the offsite storage location and based on the selected files that need to be restored. The 
restore archives are progressively increasing in size during the restore process. First, small archives 
are packed and transmitted and while these smaller archives are being processed larger ones are 
created and transmitted to your computer. This process maximizes the restore speed considerably. 
Therefore, a storage location for the received archives is needed to hold them temporarily and an 
unpack location is required that holds the files that are being extracted from the archives before 
these files and folders are put in the user specified final location on the computer. Both, the 
‘Download Location’ and the ‘Unpack Location’ are temporary storage locations and the files will 
be removed from these locations after a successful restore process. Once the restore process is 
complete the restored files and folders will be available in their specified locations. Usually, files 
that are put back onto the computer are marked as new and would therefore be backed up again. 
Since these files have been restored from the offsite backup location they still exist there as well 
and there is usually no need to back these up again unless they have been changed. Therefore, the 
checkbox ‘Mark restored files unmodified’ is checked, which will prevent these files from being 
backed up again. 
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The schedule refers to the dates and times an automated backup process starts und runs. 
Depending on the selection from the drop-down menu the backups can be unscheduled meaning 
they will be initiated manually or run at a specified day and time. There is an option to shut-down 
the computer after the backup has completed. 
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In the ‘Excluded Files’ list files and folders are specified that are excluded from being backed up. 
This list supersedes the manifest selections if there is an overlap. 

Also, a user can specify additional files and folders to be excluded from being backed up in order 
to reduce the amount of unnecessary storage space or shorten the backup time. Usually, excluded 
from backup are temporary files, deleted files that are still in the recycle bin and Windows 
operating system files. 

The use of wildcard characters such as ‘*’ (star) or ‘?’ (question mark) are possible. A checkbox to 
reset the selection to its original state (default settings) is provided when a user wants to undo 
added selections. 

In order to make changes to the list of excluded file types or folders select what you would like to 
change and click on ‘Edit’. The window will change and the ‘Add’ button is replaced by two 
buttons – ‘Apply Edit’ and ‘Cancel Edit’ – see below. 
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The offsite location can send email notifications to inform the user about the ongoing backup 
process. This allows administrators to identify problems should they occur without starting the 
backup manager software or to review the log files. The character limit is 500 and allows for 
multiple email addresses to be entered – separated by commas. The ‘Status Tray’ also provides 
feedback on the computer about the ongoing backup processes by popping up message bubbles. 
These messages and the ‘Status Tray’ itself can be turned off by checking the box under ‘Status 
Tray’. 
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On the Performance screen you can adjust the packing priority and the transmit priority. By 
increasing the packing priority, the backup will use more of the CPU and finish faster. 
However the downside is that this will decrease performance on other applications. If 
backups occur constantly, you should leave the setting to ‘Normal’, the default. If backups 
occur at night when no other applications are running, you can increase the setting to 
improve backup times. The opposite is true, if you experience performance degradation 
during daytime backups, you can reduce the priority to improve overall performance, but 
this will increase backup times. If you are unsure, leave it set to ‘Normal’. 

 
The Transmit priority setting is similar to the packing priority in the sense that increasing 
performance will speed up your backup transmission to offsite accounts. This may decrease 
network performance for other applications. Lower the Transmit priority if you see performance 
degradation on other applications. Higher priority will shorten backup times while lower priority 
will increase backup times. If you are unsure, use ‘Normal’ this is the default setting. 

 

 



GPMICRO, INC. © 2012 (0318) 

 50 

 

Log files are files that contain information about the past backup and restore processes. This 
information can be helpful for trouble shooting or is just informational in regards to what files 
have been backed up or which files have been restored. A location can be specified to store the 
log files as well as how many log files should be stored before the oldest log files will be removed. 
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Here a local storage location can be specified. The storage location can be an internal, external or 
mapped drive (share) on a network. The content of the storage location can be password 
protected. Section 5.1 describes the setup in more detail. 
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6.6. Find Files and Folders 
 

From the Menu bar select ‘Actions’ and then ‘Find Files and Folders’ which is a tool that helps to 
find data on your local computer as well as data that has been backed up. 

 

After starting ‘Find Files and Folders’ from the ‘Actions’ menu item  the following window opens 
and offers a choice between searching the backed up data (Archive search) or data on the local 
computer (Computer search). 

 

When ‘Archive Search’ is selected then the following window starts up.  
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During startup of the search tool an initial synchronization occurs that will help to speed up the 
search process. Once the synchronization is completed the tool can be used for file and folder 
searches. 

 

Now the file or folder names can be entered including wildcards as well as a preferred search 
location (folder path) with the help of a ‘Browse’ button. 
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The file view window shows the search results. When you select a file and click on the ‘Go To’ 
button or just double-clicking on a file will take you to the file location in the Backup Manager. 

Under ‘Advanced Search Options’ the following window pops up and offers further 
configuration options such as a selection of specific date and time ranges for the search or a 
selection of specific archives or archive ranges. Furthermore,  there is a choice regarding the file 
versions to be displayed, e.g., only the newest file version or all file versions. 

In order to activate the changes in the ‘Advanced Search Options’ window it is necessary to check 
the check box next to ‘Restrict search by modification date and time’. 
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When ‘Computer Search’ is selected then the following window appears with similar selections as 
described under the ‘Archive Search’. 

 

The file view window shows the search results. When you select a file and click on the ‘Go To’ 
button or double-clicking on a file will take you to the file location in the Backup Manager. 

 

The advanced search options allow for configuration of the search which can speed up the search 
considerably. 

Search Tips: When the extension of a file is known but not the name a ‘star’ = * can be used as a 
wildcard for the name such as ‘*.jpg’ which will look for all files with this extension. When part of 
the name is known as well then this information can be used e.g., ‘my*.jpg’ or ‘*my.jpg’. When the 
number of characters is known then a ‘?’ can be used instead of the unknown characters, e.g. 
????.jpg will look for 4 character long files with the extension ‘.jpg’ such as 1234.jpg or 1020.jpg or 



GPMICRO, INC. © 2012 (0318) 

 56 

AbcD.jpg, etc. There are many ways the ‘*’ and the ‘?’ can be combined with letters and numbers 
in order to speed up the search and limit the potential matches. The advanced options allow 
further limitations such as limits by dates, times, file types and sizes. 

 

 

6.7. Login and Password Changes 
 
The ‘Login’ shortcut can be found on the Tool Bar and under ‘Edit’ off the Menu Bar. 

 

In the ‘Login’ window the user credential can be changed for access to different online accounts. 
Usually, the ‘Username’ is the same but there might be different units associated with this 
username as well as passwords.  
 
Note: Automated backups require that the passwords are stored locally and the box is 
checked. 
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Passwords can be changed when selecting the ‘Change Password’ button for each user and unit. 

 

 

After a new password has been selected click on ‘OK’ to apply this change. 

 

6.8. Software Updates/Upgrades 
 
GPmicro, Inc. releases from time to time new versions of the dinKum Backup Software 
with new features and/or bug fixes. It is recommended to install these newer versions when 
available. When the dinKum Backup Software is installed and running on your computer 
you will be notified about new available updates. There is also the option of checking for 
updates from the help menu. 
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7. The Status Tray 
The Status Tray is a program that allows quick interaction with the backup process, shows 
progress reports and the configuration of messages that are initiated by the backup process.  

The Status Tray program can start automatically when the computer starts, it can be started from 
the Programs Menu (‘dinKum Backup’ folder) and it starts when the Backup Manager is started. 

The Status Tray is located at the bottom right of your screen and indicated by the dinKum logo 
(dog). 

 
 

Right-click on the dinKum logo and the following menu appears. From this menu you can enable 
popup messages (balloons), enable automatic startup of the status tray when the computer starts, 
start and stop (cancel) a backup and start the ‘Backup Status’ window that show progress of 
ongoing backups. 
 

 

When selecting ‘Run Backup Now’ select a schedule from the schedule list and a backup starts 
immediately. In the example below only one schedule exists. 
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The ‘Backup Status’ window shows the progress of the backup process. In general a backup 
process can be divided into three main steps. For large backups each step can take a long time. 
Therefore, when you get started and want to monitor the progress select a small set of files and 
folders with less than 1 GB total. 
 
First, the files and folder selected for backup from the manifest are grouped and prepared for 
packing in so called Archive files.  
 
Second, the grouped files are compressed and encrypted and packed.  
 
Third, the packed archive files are then transmitted offsite or stored on a local storage device.  
 
The blue progress bar shows the packing progress and the bottom left area of the window 
contains the packing statistics. 
 
The progress bar for the transmission is green and the transmission statistics are shown on the 
bottom right including an estimated completion time. 
 
The top part contains logging information on the total progress of the backup and serves as a 
history for recent backups. Once the backup is complete a log file is created that can be viewed 
with the ‘dinKum Log File Viewer’ located in the ‘dinKum Backup’ folder in the programs menu. 
There is also an option to start the log file viewer in the Backup Manager under ‘Tools’ and ‘View 
Log Files’. There is a log file for each archive that has been created and each log file contains the 
file names of the files that have been backed up as well as other information. 
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Below is a status view of a recently completed backup. 
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8. Starting a Backup 
 

8.1. Backing up from the dinKum Backup Manager 
 
The dinKum Backup Software runs scheduled backups automatically and in the background. The 
computer needs to be turned on in order for backups to occur but a user does not need to be 
logged on. The dinKum Backup Manager is a tool that can be used to change backup settings and 
selections but is not required for automatic backups to run. A system administrator can disable it 
in order to prevent users from making changes to backup settings. The dinKum Backup Manager 
can be used to start a backup without using a schedule by clicking on ‘Backup Now’ located in the 
Menu under the ‘Actions’ tab. This will backup the selections of the active manifest (Section 5.4). 
 

 
 

Another way to start a backup manually is by clicking on the green up-arrow on the menu. 
 

 
 
As discussed in the Section 5.4 ‘Select Files to Backup’ a file needs to be created that contains the 
files and folders that the user would like to backup. The name is shown above the menu and in 
the above example it is called ‘dinKum_Backup2.mnf’.  This filename can be anything you chose 
such as ‘My_Daily_Backup’.mnf’ or ‘Backup_of_my Docs.mnf”, etc. The extension ‘.mnf’ is 
short for the word ‘Manifest’ which is geek-speak for the files and folders selection file. There is 
no limit on how many manifests you create but only one manifest will be used per backup (the 
one selected as shown in the example above). If you would like to create a new manifest do the 
following. Start the Backup Manager from the ‘dinKum Backup’ folder from the Program Menu. 
The Backup Manager has four panes that can be individually re-arranged and resized to fit your 
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screen. In the example below the left pane is called ‘Backup Selection’. In that pane you can 
expand folders and view the contents such as files and other folders by clicking on the boxes with 
the +. The folders can be collapsed by clicking on the –. When you click into an empty box next 
to a file or folder a checkmark þ will appear marking the selection. When you click in the same 
box again the checkmark will disappear. A checkmark is grey þ when NOT all files and/or 
subfolders are selected. This happens when you select a folder and then unselect a file or 
subfolder that is within that folder or when you select only one file or folder within an expanded 
folder. 
 

 
 

Important!!! There is an important difference in how folders are selected. These are the inclusive 
selection and the exclusive selection options. 
Inclusive Selection: When a folder is selected þ this automatically selects all other files and 
folders in that folder. When at a later time new files and folders are created within that folder they 
will be automatically added to the selection and will become part of the backup manifest. There is 
no need to go back and use the Backup Manager to include these new files and folders. 
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Exclusive Selection: When you select all files and folders within a folder individually then new 
files and folders will NOT be added automatically. You will need to manually include any files or 
folders that you want included in your backup. 
 
While selecting files and folders the Backup Manager shows the total size as well as the number of 
files and drives. The Backup Manager also shows the selected storage location (bottom left). In 
our example on the previous page it is E:\dinKumStorage\ a folder on the E-drive. 
 
Once you are happy with your selection of files and folders for backup then save the new or 
changed manifest file by clicking on ‘File’ in the Backup Manager and select ‘Save’. Should you 
forget to do this and select ‘Backup Now’ right away then the following dialog box appears 
prompting you to save the changed manifest. Select ‘Yes’ to save the changes. 
 

 
 
More options that can be configured for a manifest can be found in the menu under ‘Edit’ in 
‘Settings’ (see Section 6.5). 
 
After saving the changes the backup process will begin and popup messages, which are displayed 
on the bottom right of the screen will show how the backup progresses. Once the backup is 
complete the following message will appear. 
 

 
 
New files and folders can be added to an existing manifest without starting the dinKum Backup 
Manager through Windows Explorer. Select files and/or folders in Windows Explorer and right-
click on your selection. In the appearing menu (see example below) select ‘dinKum Backup’ and 
then ‘Add to Backup List’. 
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The following dialog might appear depending on your computer configuration. 
 

 
 
Click on ‘Yes’ to continue. Then the following dialog shows the backup file list (manifest) details 
and the schedule can still be changed at this time. Every schedule can have its own manifest file. 
For more details see Section 5.3 on Schedule Backups. 

 

 
 

The dialog box shows the backup size of the existing manifest as well as the additional size and 
the new total size. Once you click on continue the following message appears and asks for 
confirmation. Click on ‘OK’ in order to proceed. 

 

 
 

When the next backup runs for this schedule the new selection will be backed up. 
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8.2. Backing up from Windows Explorer 
 
You can immediately backup a file or folder from the Windows file browser such as Windows 
Explorer by a right-click on the file or folder you want to backup and then select ‘Backup Now’ 
from ‘dinKum Backup’ located in the appearing menu. 
 

 
 
 
The following dialog might appear depending on your computer configuration. 
 

 
 
Click ‘Yes’ to continue. The next dialog box shows the backup details that can still be changed at 
this time. 
 
The last saved settings from the Backup Manager are shown in the dialog box and these are also 
the settings for the scheduled automated backups. Nevertheless, a different schedule and backup 
location can be selected at this time if needed. 
 
Furthermore, a choice can be made if all selected files will be backed up or only the files that 
changed or only the files that were never backed up or changed. 
 
IMPORTANT: ‘Shadow Copy’ is geek speak for backing up open files – meaning files that are in 
use by a program such as an open Word document. Shadow Copy only works for files on your 
local computer and not on mapped drives that are located on other computers. It is 
recommended to install the dinKum Backup Software directly on computers where you expect to 
backup open files. Otherwise these files will not be backed up.  
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Popup messages at the bottom right of the screen show the progress of the backup operation. 
Once the backup is complete the following popup appears. 
 

 
 
 

8.3. Backing up from the Status Tray 
 
Another way to initiate an immediate backup without starting the dinKum Backup Manager can 
be done through the Status Tray that is described in Section 7. The Status Tray also allows 
selecting a schedule should several schedules exist. For more details on schedules, what they do 
and how to configure them see Section 5.3 about ‘Schedule Backups’. 
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9. Restoring Data 
Successfully restoring files and folders is the most important part of a backup and recovery 
plan. The day will come when restoring data is necessary and therefore it is highly 
recommended to test restoring some backups to an alternate location to become familiar 
with the restoration process so when the time comes, you will be confident you can restore 
the correct files. 
 
Restores must be performed from within the Backup Manager. This means you should be 
familiar with the way the Backup Manager is organized and its various options. 
 

9.1. Overview 
 
The Backup Manager is divided into four Panes – three Panes and one View. The panes are 
detachable and can be moved around, changed in size and location. This can be done by 
selecting the top part of the panes and while holding down the left mouse button and 
dragging the pane across the screen. They can be turned on or off from the Tool Bar (right 
most icons ) or from ‘View’ on the menu. By default, they are all turned on and 
visible. The left pane titled ‘Backup Selection’ is used to select files and folders for backup 
and shows the files and folders that are located on your local system. The remaining panes 
and view are used for viewing and restoring files that are located offsite or on your local 
backup device. It is possible to make selections for restore from any of these panes or view.  
 

 
 
The ‘Backup Listing’ Pane is used to display the list of archives that have been backed up. 
The ‘Backed Up Folders’ Pane displays the folders contained in the archive(s) that is selected 
in the ‘Backup Listing’ Pane. The right most ‘Backed up Files & Folders’ View displays the 
files and folders from the selected folder located in the ‘Backed Up Folders’ Pane. You can 
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restore directly by right clicking on items from any one of these 3 Panes and clicking on 
restore from a context menu that is displayed at the mouse cursor. 
 

 
 

Or 
 

 
 
You can also use the down arrow button on the Tool Bar. 
 

 
 
Or you can use the ‘Restore Now’ menu item from the ‘Actions’ menu to restore any 
selected item from the ‘Panes’. This is equivalent to restoring from the context menus with 
the difference noted here. 
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If you have items selected in multiple Panes and you use the menu or tool bar button, there 
is an order of precedence used to decide which Pane selection is used by the restore. If you 
have one or more items selected from the right most, files and folders view, then this will be 
restored, the other Pane selections are ignored. If you have an item selected from the 
‘Backed Up Files’ Pane (and have nothing selected from the files and folders View’), then 
this will be restored. And finally, if you have selections from the archives list but nothing 
selected from the other Panes, then the selections from archives list will be restored. You 
can unselect any selection by clicking into a white space next to what is selected. 
 
The ‘Backup Listing’ Pane lists the backed up archives in your account. It displays up to 500 
archives at a time. Directly above the archives the list count is displayed. If you have more 
than 500 archives, you can use the ‘Newer’ and ‘Older’ buttons to page through the archives. 
You can also use the vertical scroll bar to scroll the list up or down within the current page. 
When you click (select) an archive in the list, the ‘Backed Up Folders’ Pane changes the 
displayed folders to reflect the content of the selected archive. 
 

 
 
dinKum Backup uses version control and stores multiple versions of the same file. Usually, 
the latest version of a file is the version that you want to restore. Nevertheless, there are 
instances when the latest version of a file is not the version that you want to restore. This 
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could be because the file on your computer got corrupted, infected with a virus or simply 
overwritten with wrong data before it was backed up. In cases like this you want to restore a 
previous version of that file. The dinKum Backup software stores up to 3 versions of a file 
when backing up offsite and an unlimited number of versions for local backups. In order to 
change the file and folder view based on date and time of the existing archives you can 
choose from three options from the drop down list at the top of the ‘Backup Listing’ Pane. 
The three settings are: ‘Newest Data’, ‘Data in Archive’, and ‘Disregard Data Before’. 
 

 
 
‘Newest Data’ causes the ‘Browse Backed Up Folders’ Bar to display the newest version of 
each file beginning with the date of the selected archive and all newest files that are in older 
archives. 
 
‘Data in Archive’ displays only those files and folders that are contained in the selected 
archive. 
 
The ‘Disregard Data Before’ option displays the newest version of files and folders from the 
newest archive up to the selected archive. All files and folders that are in archives older than 
the selected archive are not displayed (disregarded). This last option can be used to filter out 
files older than a particular archive date. 
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9.2. Complete Archive Restore 
 
You can restore complete archives by selecting one or more archives from the archives list in 
the ‘Backup Listing’ pane. 
 

 
 
Restores from the files and folders view (right pane) are treated slightly different. If you 
select a single file, you have the choice of selecting both its restore location as well as the 
filename. Effectively, you can change its name during the restore process. When you choose 
multiple items in the list, you must choose a folder location and the selected contents and all 
that it contains will be restored to the folder during the backup process. 
 
When the restore process is initiated by any of these methods described above, the following 
message will be displayed. You will have the choice of restoring data to its original location 
or an alternate location. Click ‘No’ to restore to an alternate location, otherwise click ‘Yes’. 
You can cancel the restore at this point by clicking on the ‘Cancel’ button. 
 

 
 
If you choose an alternate location, you will be presented with the folder selection dialog 
window. You can expand and select the location to restore to. Click ‘OK’ after you make 
your selection to proceed or ‘Cancel’ to cancel the restore. You can also use the ‘Make New 
Folder’ button to create a folder under the currently selected item in the list. 
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After selecting the location, a dialog box will be asked how to mark the restored files. This 
affects how the files will be treated on the next backup. If you select ‘Yes’ at the prompt, the 
files will not be backed up again on the next backup unless the files have changed since the 
restore. When ‘No’ is selected then the same files will be backed up again during the next 
backup even when they have not changed. You can select ‘Cancel’ at this point to cancel the 
restore. The answer to this question might seem unimportant since you are restoring files 
that are already backed up but this can affect future restores. If you are restoring older files 
and don’t mark them as unchanged they will be backed up again and will become the newest 
files in the backup archives.  
 
In most cases it is suggested to just click ‘Yes’ and to continue with the restore.  
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9.3. Restore Progress 
 
After you make this selection, the restoration process will begin and the following progress 
window will be displayed. You can click ‘Cancel’ to terminate the restore process at any time. 
 

 
 
The progress window has three progress meters: Server Progress, Receive Progress, and 
Restored Files progress. These panes move independently of each other as the processes are 
running in parallel to achieve the maximum recovery performance. Restoration involves the 
offsite server as the server must compile the files from the storage locations, encrypt and 
compress them so they can be transferred to your computer. The server begins sending data 
in restore archives as soon as the first archive is ready. Then the restore program begins to 
extract and restore the data to your computer as the archives are received. 
 
The statistics reported on this screen also displays the number of bytes received as well as 
files and bytes restored during the restore process. 
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9.4. Restore Results 
 
When the restore process completes, click on the ‘OK’ button. This will display the ‘Restore 
Results’ window shown below. 
 

 
 
The ‘Restore Results’ window has 5 tabs that contain information about the files restored. 
The ‘Summary’ tab displays the overall information about the restore. This includes the start 
and end time, the destination of the restored files and folders, the number of files restored, 
the bytes restored, and files skipped or not sent. 
 
The ‘Restored Files’ tab contains a list of the files that have been restored. This list will not 
contain files that appear on the other tabs. 
 
This ‘Skipped Files’ tab displays files that could not be restored along with the reasons why 
the files where skipped. This could be because the file names are too long, or you might not 
have permission to write to the destination location. 
 
The ‘Not Sent’ tab will contain a list of files that could not be gathered form the server. If 
you have any files on this tab, you should try your restore again at a later time. If you 
continue to have problems please contact support at GPmicro. 
 
The ‘Permission Errors’ tab applies to files being restored to a Linux share. Normally this 
tab will display ‘None’. 
 
The ‘Restore Results’ window also has a menu option to print the report. Be advised when 
using this option as the entire contents of all tabs are printed and this can be quite long. 
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After you review the results, click the ‘Exit’ menu option to exit the report. The restore is 
complete at this point. The Restore Results can also be viewed at a later time in the Log 
Viewer. This is located in the ‘Tools’ menu of the Backup Manager. 
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10. Backup Schedules 
The dinKum Backup software supports multiple backup schedules to provide maximum 
flexibility for your backups. Schedules can be used to define backups of the same or 
different files to be backed up at different times to both your local storage area and your 
offsite account. For example, you could schedule daily local backups and weekly offsite 
backups. 
 
During installation, the software automatically configures and creates the first schedule for 
you called the “Primary Schedule”. You can add up to 97 additional schedules and provide 
descriptive names for them as needed. A schedule defines which files to backup, the backup 
type (Full, Full/Changed, etc.), backup days/times, and the backup location (local storage 
area and/or offsite account.) 

 
Almost any option that affects the backup can be configured on a per schedule basis. See the 
‘Options Matrix’ for more information on which options are global to all schedules and 
which can be configured for each schedule. 

 
The ‘Archive Client’ service is the backup agent that runs the backups based on the 
schedules you define. The ‘Archive Client’ only allows one backup to run at a time. When a 
scheduled backup occurs while another backup is in progress then the scheduled backup is 
delayed. The scheduled backup will run automatically after the backup in progress completes 
or is cancelled. The order of pending backups is indeterminate – it is therefore 
recommended to setup the schedules in the preferred order by selecting the time and dates 
appropriately. This is not critical when only one schedule is selected. A schedule can be 
changed at any time but the changes will not take affect if a backup is pending or in progress 
for the schedule. 
 

10.1. Configuring and Using Schedules in the Backup Manager 
 

Schedules can be added, changed, or deleted through the Backup Manager application. In 
addition to defining backups for the ‘Archive Client’, schedules act as views while in the 
Backup Manager. For each schedule, you can define both a local storage area and an offsite 
account location to view in the Backup Manager, which can be different from other 
schedules. However, only one of these locations at a time can be used for the backup 
location when the backup occurs. The Backup Manager allows you to view either the local or 
offsite account storage areas without changing the backup location. 

 
The buttons on the tool bar that are related to schedules are shown in the image below. 
These will be discussed in more detail later. 
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10.2. Changing Schedule Views in the Backup Manager 
 
To change the Backup Manager view to that of a different schedule you select the schedule 
from the ‘Schedule Drop Down’ list from the tool bar shown below. 
 

 
 
Changing the schedule view may cause other items to change in the Backup Manager if the 
selected schedule is different from the current one. For example, in the image below, the 
manifest file and storage area are different. 
 

 
 
Since the manifest file is different in the example above, the selections in the ‘Choose Which 
Files To Backup’ have changed. The ‘dinKum Backup Listing’ pane’s archive list changed, 
the ‘Browse Backed Up Files’ pane, as well as the file list pane have also changed to reflect 
the ‘OFFSITE STORAGE’ location. In addition, the information displayed in the status bar 
at the bottom of the Backup Manager will change accordingly. 

 
To change between local and offsite storage view for the current schedule, select the location 
from the ‘Storage Location Drop Down’ list from the tool bar. It is shown as the right most 
drop-down list in the image above. When you do so, you will be asked if you want to make 
the select location to be the backup location for the schedule. A message similar to the one 
below will be displayed. 
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If you answer yes, the location viewed in the Backup Manager will be the same as the next 
backup for this schedule. If you choose no, the location viewed in the Backup Manager will 
not be the same as the next backup for this schedule. 
 
Changing between local and offsite storage causes the ‘dinKum Backup Listings’, the 
‘Browse Backed Up Files’, and the file list panes in the Backup Manager application to 
change reflecting the new location. Information on the status bar will change as well to 
reflect the new location. The file list will not change however because it is assigned to the 
schedule, not the backup location. 
 

 
10.3. Adding a New Schedule in the Backup Manager 
 

To add a new schedule, you click on the Schedule Button on the tool bar shown in the image 
below. The add process will prompt you for a schedule name and then run the Schedule 
Wizard to allow you to make changes to the new schedule. When the wizard is complete, 
you will automatically be switched to the new schedule view allowing you to make other 
changes such as backup file selections or local and offsite storage location. The process is 
described in more detail below. 
 

 
 
The add schedule function first prompts you for a new schedule name shown in the image 
below. Create a descriptive name for the schedule and click OK to proceed. You can change 
the schedule name later from the actions menu. 

 

 
 

After you choose a name, the Backup Manager will copy the options selected for the current 
schedule you have selected as a starting point for the new schedule and then run the 
Schedule Wizard which will step you through screens to allow you to change the backup 
type, backup dates and times, backup files selection, backup performance options, local 
storage area, and the offsite storage location. You can click the ‘Next’ or ‘Back’ buttons to go 
forward or backward through the Schedule Wizard. If you click ‘Cancel’, the wizard will exit 
and leave the default settings. Since the schedule is copied from the current schedule, the 
new schedule will be a copy of the current schedule if you cancel the wizard. 
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Refer to Section 5 for more information on configuring the backup schedule. Click the 
‘Finish’ button when you are done entering your information and the wizard will complete 
and return you to the Backup Manager. You can change settings for this schedule at a later 
time from the ‘Settings’ option of the ‘Edit’ menu or by re-running the schedule wizard from 
the ‘Schedule Wizard’ option of the ‘Tools’ menu. 

 
 
10.4. Delete a Schedule in the Backup Manager 

 
To delete a schedule, you click on the Delete Schedule Button on the tool bar shown in the 
image below. You cannot delete the Primary Schedule. 
 

 
 
You will be prompted to confirm if you want to delete the schedule. Click ‘Yes’ to proceed 
otherwise click ‘No’ to cancel the delete. After the schedule is deleted, you will automatically 
be switched to a different schedule. 
 

 
 

 
10.5. Backup Manager Schedule List View 

 
You can display a list of your schedules in the file list pane (right most panes). To select this 
view click on the Schedule View button shown in the image below. The button will be 
pushed in while in this view. Click it again and the view will switch back to the archive file 
list view and the button will pop out again. 
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From this view, you can see important information about each schedule at a glance, such as 
the name of the schedule, if it is active, when and how often it runs and where it backups to. 
It also makes it easier to make changes or perform functions on more than one schedule. 
Simply select a schedule and click on the button for the operation you wish to perform. If no 
schedule is selected while in this view or if you are in the file list view, operations will apply 
to the schedule in the schedule drop down list. 

 
You can also right click on a schedule name to gain immediate access to various schedule 
related functions. Only the functions that are available for the schedule will be displayed. For 
instance, you cannot delete or turn off the Primary Schedule so these options are not 
available for the Primary Schedule. You can also double click on a schedule to invoke the 
Schedule Wizard for that schedule. 

 
Below is an image of the schedule view. It displays columns of information for each 
schedule as defined below. 
 

 
 
Schedule Name – is the name you gave when the schedule was created. 

On – determines if the schedule is turned on (it will run) or off (it won’t run). 

List File – the file that contains the list of files to be backed up by the schedule. 

Type – the schedule type can be ‘Un-scheduled’ (manual), ‘Once’, ‘Weekly’ or ‘Monthly’. 

Days – the days of week or month depending on the schedule type. 

Times – the time of day or the hourly backup interval displayed as ‘Every X hours’. 

Offsite/Local – the storage location is either ‘LOCAL’ or ‘OFFSITE’. 

Location – the offsite login name, server and port, or the local storage location. 

Backup Type – the backup type as ‘FULL’, ‘FULL/CHANGED’ or ‘CHANGED’ 
determines the criteria to backup individual files. 

 
The following chart explains which settings are defined global to all schedules or can be 
defined separately per schedule. In the Backup Manager, changing the settings applies to the 
selected schedule when in the Schedule View otherwise, changing settings applies to the 
schedule in the drop down list of the toolbar.  
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Settings All 
Schedules 

Per 
Schedule 

Backup Manager View   
LOCAL STORAGE (Can be same for different schedules)  X 
OFFSITE STORAGE (Can be same for different schedules)  X 
Backup Location (Can be either local or shared)  X 
Manifest File (Separate or shared between schedules)  X 
Backup Manager – Edit Settings   
Exclude Files   

Exclude file list X  
Notifications   

Receive Emails X  
Disable automatic startup of Status Tray X  

Performance   
Packer Priority  X 
Transmit Priority  X 

Log Files   
Maximum number of latest logs  X 
Location to store logs  X 

Local Storage   
Configure Local Backup  X 
Storage Location  X 
Working Location  X 
Remember Password  X 

Offsite Location   
Account Name/Unit  X 
Remember Password  X 
Server/Port  X 

Archives   
Temporary Archive Location X  
Maximum Archive Size  X 

Backup Type   
Backup Type (Full/Changed, Full, etc.)  X 
Track Full Backup files across accounts (or each account)  X 
Leave backed up files as changed  X 
Volume Shadow Copy options  X 

Restore   
Download Location X  
Restore Unpack Location X  

Schedule   
Schedule Type (Unscheduled, Once, Weekly, Monthly)  X 
Day Selection  X 
Time Selection  X 
Shutdown computer after backup  X 
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11. Data Management 
 

11.1. Overview 
 
Data structures on computers change on a daily basis due to files being moved between 
directories or files being removed/deleted. Therefore, synchronizing the online data with the 
changing data structure of the computer is necessary to reflect the changes. This can be 
accomplished either manually or automatically with the ‘File Retention and Synchronization’ tool.  
The ‘Retention and Synchronization’ item from the ‘Edit’ menu allows for defining the type and 
length of file retention for data for online storage. The default setting for the retention length is 
infinite (Retain Forever) but this can be changed for each folder if needed. 

11.2. Data Retention 
 

 

After selection of the ‘Retention and Synchronization’ menu item the following screen appears. 
By clicking on the ‘plus (+)’ sign next to the drive letter the contents of the drives will be 
expanded and displayed. 
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The status bar at the bottom of the retention and synchronization application shows: 
 
Used: Total - Total amount of storage used from selected folder (includes up to 3 file 
versions) 
 
Recover - Amount of storage that would be recovered from selected folder (includes up to 
3 file versions) 
 
Files: Total - Total number of unique files from selected folder (counts multiple file 
versions as one) 
 
Removing - Number of files that will be removed from selected folder (counts multiple file 
versions as one) 
 
New – New number of files missing on local system when compared to online location 
(counts multiple file versions as one) 
 
Returned - Number of previously missing files that returned to the local system (counts 
multiple file versions as one). Online location will be notified that file is no longer missing 
on local system and therefore does not need to be removed from online location, either. 
 

11.3. Data Synchronization 
 
The colors of the files and folders relate to the location of the data. When a folder or file is blue 
then they are only located on the local computer and not online. When the color is red then the 
files and folders are only located online. Files and folders are shown in black when they are stored 
locally and online.  
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The retention settings are saved in a file, the ‘Retention List’ and that list can be selected 
through the ‘Browse’ button above the file and folder view window. On the right hand side 
of the window the retention period can be specified. In the above example it is set to ‘Retain 
Never’ for the selected folder. The other options are ‘Inherit’ and ‘Forever’ in the drop-
down list or a number can be entered directly into that box. This number reflects the 
number of days for which the data will be retained online before it will be deleted. For 
example, a file on your local system has been deleted and then a certain number of days later 
it will be deleted from the online location, too. This only makes sense when the file is no 
longer needed. The backup primarily serves unintentional deletion of files and folders so that 
these can be restored. Therefore, the default setting for the retention period is ‘Forever’ 
which should only be changed when the affected files and folders will not need restoring at a 
later time. 
 
These setting will be the same for all subfolders when for those ‘Inherit’ is selected which is 
the default setting. Click on ‘Set Retention’ to activate your selection. When ‘Auto 
Synchronize’ is checked the dinKum backup software will automatically initiate the 
synchronization for the selected folder and its subfolders. By clicking on ‘Synchronize All 
Folders’ a manual synchronization can be initiated. 
 

 
 
Each synchronization process creates a log file with a report on what files and folders were 
synchronized as shown in the example below. 

 
The synchronization results window has five tabs that provide a summary, the list of files 
that have been deleted from the offsite storage location, the files that were retained and if 
there were any warnings or permission errors. 
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Log-file report before synchronization: 
 
Same information as provided by the status bar in the File Retention and Synchronization 
window. 
 
Log-file report after synchronization: 
 
REMOVED (ONLINE FILES) - Number of files that were removed from online storage 
RECOVERED (ONLINE SPACE)- Amount of online space recovered 
RETAINED (ONLINE FILES)- Number of files that are marked for removal from online 
storage location at a later time based on retention settings 
NOT PROCESSED (ONLINE FILES)- Number of files that couldn't be processed 
 
The Retention/Synchronization Results can also be viewed at a later time in the Log Viewer. 
This is located in the ‘Tools’ menu of the Backup Manager. 
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12. DinKumd Service Installation Instructions for Linux 
 

12.1. Overview 
 
The DinKumd Service (DDS) is provided for Linux users that are backing up or restoring 
files using the Windows dinKum Backup Software (Client) with SAMBA shares. SAMBA 
does not preserve Linux group, ownership or file permissions when accessed from Microsoft 
Windows Systems. The DDS provides a method for the Client to get the Linux file group, 
ownership, and file permissions during backup operations and will set them back during 
restores. 
 

Users that strictly use SAMBA shares as file server for Windows 
applications will not require this service. 

 
12.2. Obtaining DDS 

 
The DDS can be found in the installed GPmicro program files folder on Microsoft 
Windows Systems in a file called “dinkumd.tar”. Typically this can be found in “C:\Program 
Files\GPMicro\dinKum Backup” on 32 bit versions of windows or “C:\Program Files 
(x86)\GPmicro\dinKum Backup” on 64 bit versions of Windows. On some systems, the 
program files folder may be on a drive other than ‘C:’. 
 
First copy the “dinkumd.tar” file to your Linux System. The easiest way to do this is to map 
a SAMBA share, make a folder called “dinKum” on the share and copy the file from the 
Client installation folder to the “dinKum” folder on the share. Then logon to Linux as the 
“root” user and change your shell working directory to the “dinKum” folder on the Linux 
system to perform the installation. See the ‘Configuring SAMBA Shares’ section below for 
help on this topic. 
 
NOTE: While configuring the SAMBA share on Linux, be sure to run the ‘smbpasswd’ 
command to create the Windows mapping logon credentials for the share. 
 
For example, to set the mapping user credentials for user ‘bob’, as the “root” user on the 
Linux server, type the following command from the shell prompt: 
 
smbpasswd bob 
 
You will be prompted for the password: 
 
New SMB password: _ 
 
The password will not show up (echo) as you type for security reasons. 
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12.3. Preparation before Installation 
 
Before installing the DDS, you need to gather the following information about your Linux 
system: 
 
1. Identify an unused TCP Port number for the DDS (2020 is used by default) 
2. Identify all of the SAMBA share names and their complete paths from root “/”. 

 
The DDS accepts TCP connections from the Client that is aware of SAMBA shares on 
Linux servers running the DDS. The DDS must be configured to listen and accept 
connections on specific TCP port numbers. The default port number is 2020 but any port in 
the range 2020 through 2024 is preferred. The Client will automatically detect servers using 
DDS if they use a port in this range; otherwise the Client will have to be configured 
manually to match the port used by the DDS outside this range. If the Client does not auto 
detect or does know to use a port outside the default range, the Linux file permissions will 
not be backed up and consequently, not restored when the files are restored. See 
‘Configuring Backup Software’ below to learn how to manually configure a share to use the 
DDS on SAMBA shares. 
 
If you already have another Linux service using the default port “2020”, you must change 
the DDS listening port during installation. The port number is stored in the DDS 
“/etc/dinkum/dinkum.cfg” configuration file. You can also change the port after 
installation by editing the configuration file manually and restarting the DDS. See ‘Modifying 
the DDS Configuration File’ section below to learn how to do this. 
 
To determine which ports are currently in use on Linux, you can use the following shell 
command line: 
 
netstat -l -n | grep -i tcp | more 
 
The fourth column contains the interface and port number that is in use. The last number of 
the value in that column, following the last colon (:) character, is the TCP port number. For 
example, in the sample output shown below, the ports in use are 2020, 80, 22, 631, 139, 
5900, 22, 631 and 445 taken from column 4. You would choose any other port than those. It 
is recommended that you pick a port higher than 1024. 
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Sample output: 
 

 
 
If you do not see any of the ports 2020 through 2024 displayed in the output, then they are 
not in use and should be used by you. Choose the default if available, otherwise use 2021 
through 2024. If none of those are available, you will have to choose an alternate port 
number not in use. If you choose any port other than 2020, you will have to configure it 
during installation. 
 
Also, you should make sure that the TCP port is not being blocked by a Linux firewall. If it 
is, you need to open the port in the firewall. Examine your Linux networking firewall 
configuration to determine this. After you install DDS and it is running, you want to find out 
if the firewall is blocking this port by using the Linux ‘telnet’ command. From a system other 
than the Linux server at a shell (on Linux) or DOS command (on Windows), type in the 
following command and see if the connection times out. If it times out, the port is probably 
blocked. If it connects and the screen clears, the port is not blocked. If the connect is 
successful, you can type ‘Ctrl-]’ (Control Key + ‘]’ key) followed by ‘c’ key to get the ‘telnet’ 
prompt, and then type the ‘quit’ command. Alternately, you can wait for the connection to 
time out or just close the window. 
 
telnet <server-name or IP-address> <Space> <port#> 
 
The <server-name> is the server’s network name or <IP address> is the server’s IP address 
and <port#> is the port number chosen for DDS. Between the server name and the port 
number must be a space character. 
 
In the example below, ‘telnet’ is being used to try to connect to port 2023 on server 
10.234.22.105. In this example, ‘telnet’ was unable to connect based on the output message 
from ‘telnet’. 
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The next example shows a successful connection by ‘telnet’ to port 2020 on server 
10.234.22.105.  
 

 
 
Once you configure the SAMBA shares, copy the “dinkumd.tar” file to the share, and 
choose a TCP port number for the DDS, you are ready to perform the installation. 
 

12.4. Installing the DDS on Linux 
 
From the Linux system, extract the files from the dinkumd.tar file into the “dinKum” folder 
(assume ${Share Path} is the path of the SAMBA share): 
 
cd ${Shared Path}/dinKum 
tar xvf dinkumd.tar 
 
For example, if you are sharing the folder “/home/usr1/Documents”, enter the following 
commands as user “root”: 
 
cd /home/usr1/Documents/dinKum 
tar xvf dinkumd.tar 
 
The following files will be extracted: 
 
install_dinkumd.sh – DDS install shell script 
dinkumd – DDS application 
initdinkumd – Startup script 
dinkum.cfg – Configuration file for DDS 
 
From the ${Shared Path}/dinKum folder described above, run the installer as follows as 
user “root”: 
 
cd ${Shared Path}/dinKum 
sh install_dinkumd.sh 
 
The install script will perform the following functions and this is provided as information for 
troubleshooting by advanced Linux users only. No user action is required until step 6 is 
reached, where you will be required to modify the configuration file. This requires a minimal 
amount of knowledge of the “vi” editor. If you need help with “vi”, see ‘Using the VI 
Editor’ section below. 
 

1. Stops the DDS if previously installed and running.  
2. Copies the DDS “dinkumd” to the “/usr/bin” directory.  
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3. Copies the DDS startup file “inidinkumd” to the “/etc/init.d” directory and renames 
it to “dinkumd”.  

4. Links the correct run level startup and shutdown scripts in “/etc/rc1.d” and 
“/etc/rc2.d” directories to the “/etc/init.d/dinkumd” script.  

5. Copies the “dinkum.cfg” file to the “/etc/dinkum” folder where the DDS expects to 
find it.  

6. Runs the “vi” editor on the “/etc/dinkum.cfg” file so you can edit the correct TCP 
port number and add the SAMBA share paths.  

7. Starts up the DDS.  
8. Completes the installation and returns to the shell prompt.  

 
The installation process will invoke the “vi” editor on the “/etc/dinkum.cfg” file so that you 
can configure the DDS for your system. You will be required to set the correct TCP port 
number and enter a line for each SAMBA share you wish to obtain Linux permissions for. 
See ‘Modifying the DDS Configuration File’ section below to learn how to do this. 
 
A sample configuration file using TCP port 2020 with one SAMBA share called 
“Usr1Documents” for the Linux directory “/home/usr1/Documents” would appear as 
follows: 
 
PORT=2020 
Usr1Documents=/home/usr1/Documents 
 
When you are finished making changes to the configuration file in step 6 you should exit the 
editor. This will cause the installer to continue and complete the installation. After 
installation the DDS will automatically start up and you will be ready to perform backups. 
 
The DDS will automatically start and stop when the system is booted or shutdown, 
respectively. 
 
If the service is running, you can stop it with the following shell command as the user 
“root”: 
 
sh /etc/init.d/dinkum stop 
 
You can start the service, if stopped, with the following shell command as the user “root”: 
 
sh /etc/init.d/dinkum start 
 
Or you can restart the service, if running, with the following shell command as the user 
“root”: 
 
sh /etc/init.d/dinkum restart 
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12.5. Configuring SAMBA Shares 
 
Since there are many versions of Linux with different GUI desktops available, this document 
cannot describe all the various ways a SAMBA share can be configured. Therefore it is best 
to consult the documentation on your version of Linux. This example uses both the GUI 
desktop to configure a share and then describes how to set the share user credentials so that 
it can be mapped from Windows using the ‘smbpasswd’ command from the shell prompt. 
 
Using the Shell Browser, locate the folder you want to share and right click to bring up the 
context menu. Then click on the ‘Sharing Options’ option from the menu. 
 

 
 
Click on ‘Sharing Options’ to share the folder. 
 
This will bring up the Folder Sharing dialog as shown below. Select the ‘Share this folder’ 
option and enter the share name and a comment. Be sure to select ‘Allow others to create 
and delete files in this folder’ option. (This is required by the backup Client software so that 
it can record the backed up files, which it records on the share.) When you’re sure the 
settings are correct, click on the ‘Create Share’ button and the share will be available for 
mapping. 
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Configure the ‘Folder Sharing’ options and click the ‘Create Share’ button. 
 
 
NOTE: Be sure to run the ‘smbpasswd’ command to create the Windows mapping logon 
credentials for the share. 
 
For example, to set the mapping user credentials for user ‘bob’, as the “root” user on the 
Linux server, type the following command from the shell prompt: 
 
smbpasswd bob 
 
You will be prompt for the password: 
 
New SMB password: _ 
 
The password will not show up (echo) as you type for security reasons. 
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12.6. Using the VI Editor 
 
This is not intended to be a complete tutorial of the “vi” editor but merely shows the most 
basic features and commands in order to use the editor to modify the DDS configuration 
file. 
 
To modify the configuration file with the “vi” editor, enter the following command: 
 
vi /etc/dinkum/dinkum.cfg 
 
The editor will display the first page of the file on the screen and enter visual command 
mode. In this mode, keys pressed are treated as commands and do not become part of the 
document. The “vi” editor has three basic modes as explained below: visual command 
mode; insert mode; and command line mode. 
 
In visual command mode, keys pressed are treated as commands, such as cursor movement, 
character insert or delete, or line insert or delete, etc. Keys that cause “vi” to enter insert or 
edit mode, will place the cursor in the document location on the screen corresponding to the 
command type and then switch “vi” into the corresponding mode. To return back to visual 
command mode, press the Escape key. 
 
In line insert or edit mode, characters typed on the keyboard are entered into the document 
text on the screen and become part of the document. While in insert mode, you can use the 
arrow keys to position the cursor or use the backspace or delete keys to delete characters. 
 
To enter command line mode, while in visual command mode, press the colon “:” key. This 
will clear the last line of the display and show the “:” prompt at the beginning of the line and 
then position the cursor after the prompt on the last line. There you can enter commands to 
perform specific “vi” command line functions. 
 
Visual Command Mode: 
 
Arrow Keys Move the cursor up, down, left, or right corresponding to the arrow keys. 
‘w‘-key  Moves the cursor to the beginning of the next word. 
‘e‘-key Moves the cursor to the end of the word containing the cursor or the end 

next word if already at the end of a word. 
‘b‘-key Moves the cursor to the beginning of the word containing the cursor or the 

previous word if already at the beginning of a word. 
‘a‘-key  Enters insert mode after the character in which the cursor is positioned. 
‘i‘-key Enters insert mode in front of the character in which the cursor is 

positioned. 
‘o‘-key Creates a new line below the line of the cursor and enters insert mode on 

that line. 
‘O‘-key Creates a new line above the line of the cursor and enters insert mode on 

that line.  
‘x‘-key  Deletes the character where the cursor is positioned on. 
Back Space Deletes the character before the cursor position. 
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‘c’-key and then ‘x‘-key Deletes the character at the cursor position and enters insert 
mode. 

‘c’-key and then ‘w‘-key Deletes the word at the cursor position and enters insert 
mode. 

‘d’-key and then ‘d‘-key  Deletes the line containing the cursor. 
‘d‘-key and then ‘w‘-key Deletes a word containing the cursor. 
‘Z‘-key and then ‘Z‘-key Saves the document and exits the editor. 
‘y‘-key and then ‘y‘-key  Copies the line contents into an internal ‘yank’ buffer. 
‘p‘-key Inserts a new line under the cursor with the contents of the 

internal ‘yank’ buffer. 
‘P‘-key Inserts a new line above the cursor with the contents of the 

internal ‘yank’ buffer. 
 
Command Line Mode: 
 
:w  Write back changes to the original file. 
:w <file> Write back changes to the file specified on command line. 
:r <file> Read file specified on command line into document at cursor location. 
:q  Quit or exit the editor. 
:wq  Write the file and quit the editor. 
:w!  Force writing the file back. 
:wq!  Force writing file back and quit editor. 
 

12.7. Modifying the dinKumd Configuration File 
 
Use a text editor such as “vi” to modify the configuration file “/etc/dinkum/dinkum.cfg”. 
Locate and modify the line that defines the TCP port number used by the DDS. Change the 
number from 2020 to the port you plan to use. Locate the line in the file after a new install 
that appears as: 
 
PORT=2020 
 
For example, to change the TCP port number to 2021, after changing the line it reads: 
 
PORT=2021 
 
With the “vi” editor: 
 

1. Run the command: vi /etc/dinkum/dinkum.cfg 
2. Use the up or down arrow key to go to line containing “PORT=2020” and then left 

or right arrow keys to move to the beginning of the word “2020”. 
3. Then type ‘c’ and then ‘w’ keys to delete the word “2020” and enter Insert Mode. 
4. Type “2021” and press Escape key to return to visual command mode. 
5. Type ‘Z’ and then ‘Z’ again to write the changes and exit. 

 
In the file, you can add, change, or remove share names by adding and removing lines of the 
form: 
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{Share Name}={Rooted Path of Shared Folder} 
 
In the file, the text “{Share Name}” represents the SAMBA share name and “{Rooted Path 
of Shared Folder}” represents the complete path from the root “/” of the folder being 
shared by SAMBA. 
 
For example: 
If the directory “/home/usr1/Documents” is being shared as “Usr1Documents” the line 
would read: 
 
Usr1Documents=/home/usr1/Documents 
 
With the “vi” editor: 
 

1. Run the command: vi /etc/dinkum/dinkum.cfg 
2. Use the up or down arrow key to go to line containing “PORT=2020”. 
3. Type ‘o’ to enter insert line mode on a new line under the line containing 

“PORT=2020”. 
4. Type in “Usr1Documents=/home/usr1/Documents” and then press Escape to 

return to visual mode. 
5. Type ‘Z’ and then ‘Z’ again to write the changes and exit. 

 
After saving the changes to the configuration file, the service must be restarted for your 
changes to take affect. 
 

12.8. Configuring Backup Software 
 
The Client (Windows dinKum Backup Software) can obtain Linux file permissions from the 
DDS, if installed on the Linux server hosting the SAMBA share. When choosing files to 
back up from a mapped drive while in the dinKum Backup Manager, the dinKum Backup 
Manager will require you to enter the login credentials it will use later during backups. The 
following dialog box will be displayed and during this process, it will automatically try to 
detect a DDS on the server hosting the share. If the service was configured to listen on a 
port between 2020 and 2024, the server will automatically be detected. 
 
If the server detects the service, the ‘Save remote Permissions’ checkbox will automatically 
be checked, and the port number supplied in the dialog box is shown below. If the DDS is 
configured at an alternative port, it will not be detected and you will have to manually 
configure the port number for the Windows Client. You should check the checkbox and 
enter the correct TCP port number so the backup software knows how to connect to the 
Linux server in order to obtain the permissions. If the backup software cannot connect then 
the Linux permissions will not be backed up. 
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Settings to 
configure TCP Port to obtain remote permissions from Linux 
 
During restore to a Linux SAMBA share, the dinKum Restore program will again 
automatically attempt to detect the DDS running on Linux. If it cannot detect the DDS, it 
will not restore the correct Linux permissions during file restore. 
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13. Uninstalling the dinKum Backup Software 
 
The dinKum Backup software can be uninstalled through the Control Panel by selecting 
‘dinKum Backup’ from the list and choosing ‘Uninstall’ from the menu. 
 

 
 
The following dialog boxes might appear asking for confirmation of the uninstall request. If 
you are certain that you wish to proceed then select ‘Yes’ in the dialog box below. 
 

 
 
When you only want to uninstall the software but you want to keep user specific settings 
then select ‘Yes’ below. When you select ‘No’ then all program and user data associated with 
dinKum Backup will be removed from your system. 
 

 
 
 
 

 


